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Introduction

Welcome to Adobe Photoshop Elements 6 On Demand, a
visual quick reference book that shows you how to work effi-
ciently with Photoshop Elements 6.  This book provides com-
plete coverage of basic to advanced Photoshop Elements
skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Photoshop Elements 6,
just look for the icon: New!. The new icon appears in the
table of contents and through out this book so you can
quickly and easily identify a new or improved feature in Pho-
toshop Elements 6. A complete description of each new fea-
ture appears in the New Features guide in the back of this
book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P, as a quicker alternative to using the mouse. A com-
plete list of keyboard shortcuts is available in the back of this
book and on the Web at www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshop

Get More on the Web

www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions include illustra-
tions that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com
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Workshop
This book shows you how to put
together the individual step-by-
step tasks into indepth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with project
results file at the end. The Work-
shop projects in the back of this
book and associated files are
available on the Web at 
www.perspection.com.

Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Photoshop Elements 6. Some of
the information includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
features list as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

The Workshop
walks you through
indepth projects
to help you put
Photoshop to
work.

Additional
content
is available
on the Web. 

www.perspection.com
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More Content
◆ Photographs. Download

photographs and other
graphics to use in your
Photoshop Elements
documents.

◆ More Content. Download
new content developed after
publication.

You can access these additional
resources on the Web at
www.perspection.com.

Photographs
help you use
Photoshop
Elements to 
get work done.

www.perspection.com


Importing Photos into the
Organizer

Introduction

Before you can start using Photoshop Elements to edit pho-
tos and create projects, you need to import your photos and
other media files into one or more catalogs. A catalog is a
way to reference files on your computer or other storage
device without moving them. Think of a catalog as a database
of links to your photos and media files. The catalog links keep
track of the photo’s location, file format, attached tags, and
date. A catalog can reference all the media you have on your
computer or a subset of folders. Typically, users create a sin-
gle catalog for all the media files on their computer.
However, you can create more than one for different pur-
poses, such as one catalog for work-related photos and
media files, and another one for personal use. 

You create a catalog by starting Photoshop Elements for
the first time, and then clicking Yes to the Setup Organizer
dialog box, or by using commands—such as From Camera or
Card Reader, From Scanner, From Files and Folders, or From
Mobile Phone—on the Get Photos and Videos submenu on
the File menu. After you have Photoshop Elements create a
catalog, you can start to use the Organizer to manage,
search, and fix photos and other media files. 3

3
What You’ll Do

Specify Watched Folders

Import Tags Attached to Photos

Get Photos from Files and Folders

Get Photos by Searching

Get Photos from a CD or DVD

Get Photos from a Cameras or Card
Readers

Get Photos from a Scanner

Get Photos from a Mobile Phone

Get Photos from a Video in the Editor

Add Photos to the Organizer from the
Editor

Create and Open a Catalog

Manage Catalogs

Move Files in a Catalog

Delete Files from a Catalog

Back Up a Catalog

Restore a Catalog Backup

41
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A watched folder is a folder location on your computer that Organizer
automatically checks for photos to add to the Organizer workspace. By
default, the My Pictures (XP) and the Pictures (Vista) folder is always
watched. If you have photos and other media files in other locations,
you can add them to the watched folder list. If you no longer want to
watch a folder, you can quickly remove it from the list. In addition, you
can also set options to watch all sub-folders within a watched folder,
and to specify how you want to add new files found in the watch fold-
ers, either by notification or automatic.

Specifying Watched
Folders

Add Folders to the Watched
Folders List

In the Organizer, click the File
menu, and then click Watch
Folders.

Click Add.

Navigate to and select the folder
you want to add to the watched
folders list.

Click OK.

The folder name appears in the
Folders To Watch list.

Click OK.5

4

3

2

1

5

2

4

3
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Remove Folders to the Watched
Folders List

In the Organizer, click the File
menu, and then click Watch
Folders.

Select the watch folder you want
to remove.

Click Remove.

The folder is removed from the list.

Click OK.

Change Watch Folders Settings

In the Organizer, click the File
menu, and then click Watch
Folders.

Select the Watch Folders and their
Sub-Folders for New Files check
box to watch all sub-folders in the
specified watch folders.

Select the Notify Me or
Automatically Add Files to
Organizer option to specify how
you want to add new files found in
the watch folders.

Click OK.4

3

2

1

4

3

2

1

4

2

3

2

4

3
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A keyword tag, also known as a tag, is an information label that is
attached to photos to make them easier to locate. Some tags are auto-
matically attached to a file when you create it, such as name and size,
while custom tags are manually attached by the user. You can create
your own custom tags with information important to you and attach
multiple tags to the same photo for improved organization. When you
import photos that already contain tags, you can specify whether you
want to retain, rename, delete or remap them. When you import a new
tag from an imported photo, it appears in the Keyword Tags palette,
where you can use them with other photos.

Importing Tags
Attached to Photos

Import Tags Attached to Photos

In the Organizer, click the File
menu, and then point to Get
Photos and Videos.

Click any of the commands on the
submenu to get files. 

Select the options you want, and
then click the button to start the
import process, such as Get
Photos.

If an imported photo included one
or more tags, the Import Attached
Keyword Tags dialog box appears.

Select the tags you want to import.
If a tag has an asterisk (*), a tag
with the same name already exists
in the Tags palette.

The tags not selected are removed
from the photo during the import
process.

Click OK.5

4

3

2

1

3

Navigate to the Import location

5

4
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Import Tags Attached to Photos
Using Advanced Options

In the Organizer, click the File
menu, and then point to Get
Photos and Videos.

Click any of the commands on the
submenu to get files. 

Select the options you want, and
then click the button to start the
import process, such as Get
Photos.

If an imported photo included one
or more tags, the Import Attached
Keyword Tags dialog box appears.

Click Advanced.

Select the check box next to the
tag names you want to import.

The tags not selected are removed
from the photo during the import
process.

To rename a tag, click the button
under Import as New Keyword Tag
Named, type a name, and then
press Enter.

To map a tag to an existing tag,
click the button under Use an
Existing Keyword Tag, and then
select a tag.

To clear your changes and return
to the Import Attached Keyword
Tags dialog box, click Reset to
Basic.

Click OK.9

8
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Before you import photos and videos into the Organizer, it’s important to
set file import preferences to specify the options you want for the
import process. When you get photos from your computer, the files are
not copied or moved. The Organizer creates links to them and adds
them to the catalog. If you have photo files on your computer that are
not already included in the catalog and don’t appear in the Organizer,
you can use the Get Photos from Files and Folders dialog box to navi-
gate to the folder location with the files you want and then add them or
you can drag them directly from an Explorer window to the Organizer
window.

Getting Photos from
Files and Folders

Import Photos from Files and
Folders

In the Organizer, click the File
menu, and then point to Get
Photos and Videos.

Click From Files and Folders.

Navigate to the folder location
with the files you want to import
into the Organizer.

Select the folder or the specific
photo files you want to import.

If you want to get photo files from
subfolders, select the Get Photos
From Subfolders check box.

Click Get Photos.

TIMESAVER Drag the photos
from an Explorer window into the
Organizer. Depending on the
number of photos and the speed of
the computer, you might need to
wait for the operation to complete.

6

5

4

3

2

1

6
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Add Photos from Specific
Folders

In the Organizer, click the Display
button on the Shortcuts bar, and
then click Folder Location.

In the folder hierarchy panel,
display the folder with the files you
want to import.

Right-click the folder, and then
click Add Unmanaged Files to
Catalog.

Click OK.

When files are imported, the
folder’s icon changes from an
Unmanaged Folder icon to a
Managed Folder icon.

4

3

2

1

2 3 1
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Instead of manually looking for photos and other media files to import
into the Organizer, you can have Photoshop Elements search your com-
puter and then automatically import them. You can select options to
exclude system and program folders, which typically don’t contain pho-
tos, and exclude small files, which typically are not large enough to be
photos. These options help speed up the search. As you import files
into the Organizer, you can have Photoshop Elements automatically fix
red eye on any photos that need it.

Getting Photos by
Searching

Search for Photos on Your
Computer

In the Organizer, click the File
menu, and then point to Get
Photos and Videos.

Click By Searching.

Click the Look In list arrow, and
then select the location where you
want to perform the search.

Select the Exclude System and
Program Folders check box to
exclude folders from the search
that typically don’t contain photos.  

Select the Exclude Files Smaller
Than xxx KB check box to exclude
small files that typically are not
large enough to be photos. 

You can specify the size you want
in kilobytes.

Click Search.

Select the folders with the photos
you want to import. Press Ctrl to
select more than one folder.

Select the Automatically Fix Red
Eyes check box to automatically
correct red eyes for photos that
need it when you import the files.

Click Import Folders.9

8
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When you get photos from a CD, DVD, or other external device, such as
a scanner, digital camera, card reader, or mobile phone, Photoshop
Elements first copies the photos to a folder on your computer, and then
creates a link to the file. When you get photos from a CD or DVD, you
can choose to make full- or low-resolution copies of the files. Full-reso-
lution copies are best for editing, while low-resolution are best for pre-
viewing photos and saving disk space. 

Getting Photos from 
a CD or DVD

Import Photos from a CD or DVD

In the Organizer, click the File
menu, and then point to Get
Photos and Videos.

Click From Files and Folders.

Navigate to the CD or DVD drive
with the files you want to import
into the Organizer.

Select the photos you want to
import into the Organizer. Press
Ctrl to select more than one photo
file.

Click the Copy files on import
option to make full-resolution
copies of the photos, or click the
Generate previews option to make
low-resolution copies of the
photos.

If you’re keeping a master photo
offline, type a volume name for the
CD or DVD and label the disc to
make it easier to find and
download the master when
needed.

Select the Automatically Suggest
Photo Stacks check box to group
visually similar photos together
into stacks upon your approval.

Select the Automatically Fix Red
Eyes check box to automatically
correct red eyes for photos that
need it when you import the files.

Click Get Photos.9
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If you have a digital camera attached to your computer with a cable,
you can copy photos directly from the camera to a folder on your hard
disk and then import them into the Organizer. Many digital cameras
store taken images on a card disk, which you can remove from your
camera and insert into a card reader attached or built-in to your com-
puter. The card disk works like a removable drive. You can copy photos
from the card disk to a folder on your hard disk and then import them
into the Organizer. When you download photos from a camera, card
reader, or mobile phone, Photoshop Elements uses the Adobe Photo
Downloader (APD) dialog box. You can set options to automatically 
use the APD upon device connection in Camera or Card Reader 
preferences.

Getting Photos from 
a Camera or Card
Reader

Import Photos from a Camera or
Card Reader

Connect your camera or insert the
card disk into your card reader
already attached to your computer.

If the Adobe Photo Downloader
dialog box appears, skip to Step 3.
The dialog box automatically
appears when an option is set in
Camera or Card Reader
preferences.

TROUBLE? When you attach
the camera or card reader to you
computer, you may be asked to
install software device drivers.

In the Organizer, click the File
menu, point to Get Photos and
Videos, and then click From
Camera or Card Reader.

Click Browse, and then specify the
folder location where you want to
import the photos.

Navigate to the location with the
video file you want to import, and
then click OK.

Click the Create Subfolder(s) list
arrow, and then select a format or
Custom Name to create subfolder
names.

5

4

3

2

1

12

5

Standard dialog box

3

6

10
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Click the Rename Files list arrow,
and then select a format or
Custom Name to rename the files. 

If necessary, type the filename and
starting number for renaming
filenames with sequential numbers
at the end.

Select the Preserve Current
Filename in XMP to use the
current filename as the filename
stored in the photo’s metadata.

Select the Open Organizer When
Finished check box to immediately
import the photos into the
Organizer. When you deselect the
check box, the images are
imported the next time you start
the Organizer.

Click the Delete Options list arrow,
and then select the option you
want for deleting photos.

Select the Automatic Download
check box to import photos from
the connected device the next
time you use it with the settings
you’ve selected as the defaults. 

Click Advanced Dialog to expand
the dialog box, select individual
photos you want to import, and
select the advanced options you
want for tags and metadata. 

Click Get Photos.

If the photos contain metadata, the
Import Attached Tags dialog box
appears, where you can specify
the options you want.

13

12

11

10

9

8

7

6

See Also
See “Setting Camera or Card Reader
Preferences” on page 32 for informa-
tion on setting options to import 
photos.

11

7

Advanced dialog box

8

13
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If you have a scanner attached to your computer with a cable, you can
scan photos directly from the scanner to a folder on your hard disk and
then import them into the Organizer. When you get photos from a scan-
ner, you need to follow the scanning instructions provided by the
Scanner manufacturer to complete each photo scan. As you import
files into the Organizer, you can have Photoshop Elements automati-
cally fix red eye on any photos that need it.

Getting Photos from 
a Scanner

Import Photos from a Scanner

In the Organizer, click the File
menu, and then point to Get
Photos and Videos.

Click From Scanner.

Click the Scanner list arrow, and
then select a scanner attached to
your computer or network.

To select a location for scanner
files, click Browse, select a folder,
and then click OK.

Click the Save As list arrow, and
then select the file type in which to
save scanner files and then set a
related quality level, if available.

The higher the quality level, the
higher the file size.

Select the Automatically Fix Red
Eyes check box to automatically
correct red eyes for photos that
need it when you import the files.

Click OK.

Select the scanning options you
want from the ones available from
your scanner, and then scan your
photo.

8

7

6

5

4

3

2

1

See Also
See “Setting Scanner Preferences” on
page 34 for information on setting
default options to import photos.

6

3

4

5

7

8



Chapter 3 Importing Photos into the Organizer 53

If you have a Nokia phone, Photoshop Elements recognizes the phone
when you connect it to your computer with a cable. Instead of using
this task, you should use the instructions for Getting Photos from a
Camera or Card Reader. For all other mobile phones, you can use the
From Mobile Phone command. The first time you import files from your
mobile phone, you need to specify a folder on your computer to store
the downloaded photos, which Photoshop Elements automatically
makes a watch folder, so it’s easier for the Organizer to detect and
import mobile photos into the catalog.

Getting Photos from 
a Mobile Phone

Import Photos from a Mobile
Phone

In the Organizer, click the File
menu, and then point to Get
Photos and Videos.

Click From Mobile Phone.

On secondary use, Photoshop
Elements imports the available
photos from the specified folder
for mobile phone photos.

On first use, click Browse, specify
and select the folder location
(such as Mobile Phone Photos)
where you want to import the
photos, and then click OK.

Select the Automatically Fix Red
Eyes check box to automatically
correct red eyes for photos that
need it when you import the files.

Click OK.5

4

3

2

1

See Also
See “Getting Photos from a Camera or
Card Reader” on page 50 for informa-
tion on getting photos from a Nokia
phone.
See “Setting Mobile Phone
Preferences” on page 37 for informa-
tion on setting options to import 
photos.

5

3

4

Select folder for
mobile phone photos
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If you have a digital video in a file format that Photoshop Elements can
recognize, such as ASF, AVI, MPEG, M1V, and WMV, you can open it in
the Editor, play the video in the Frame From Video dialog box and then
capture frames as individual photo files. The individual photo files are
saved with the name of the video file and a number. For example,
videoname01, videoname02, videoname03, etc. In addition to Photoshop
Elements, you also need to install the latest version of standard video
software, such as QuickTime or Windows Media Player, which you can
get for free online at www.apple.com and www.microsoft.com.

Getting Photos from 
a Video in the Editor

Capture Frames from a Digital
Video in the Editor

In the Editor, click the File menu,
and then point to Import.

Click Frame From Video.

Click Browse.

Navigate to the location with the
video file you want to import,
select the file, and then click
Open.

Click the Play button to start the
video, and then pause the video
where you want to capture the
frame.

To capture a frame as the video
runs, click the Grab Frame button
or press the spacebar. 

Use the forward and backward
arrows to display the next screen
you want to capture.

When you’re finished, click Done.

Click the File menu, and then click
Save to save each screen capture
file to a folder.

9

8
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Video clip

6

8

Saved frame from a video

www.apple.com
www.microsoft.com
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If you open or import a file in the Editor that is not currently included in
the catalog, you can add the photo to the Organizer while you save the
file in the Editor. All you need to do is select the Include In The
Organizer check box in the Save As dialog box while you save the
photo. The next time you open the Organizer, the saved photos appears
in the catalog for use in the Organizer.

Adding Photos to the
Organizer from the
Editor

Add Photos to the Organizer
from the Editor

In the Editor, open or import the
photo file you want to add to the
Organizer.

Click the File menu, and then click
Save As.

Select the Include in the
Organizer check box.

Select the Save in Version Set
with Original check box to save
the current version with the
original version.

Navigate to the folder location
where you want to save the photo.

Click Save.

If prompted, click OK to save the
current version with the original
version in a version set.
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You can create a new catalog or open an existing one by using the
Catalog Manager. Typically, users create a single catalog for all the
media files on their computer when you start Photoshop Elements for
the first time. However, you can create more than one for different pur-
poses, such as one catalog for work-related photos and media files,
and another one for personal use. When you create a new catalog, you
can create one that is accessible by all users on your computer or just
the current user logged on. If you have more than one catalog on your
computer, you can switch between them at any time. When you open
the Organizer, the last opened catalog appears.

Creating and Opening
a Catalog

Create a New Catalog

In the Organizer, click the File
menu, and then click Catalog.

TIMESAVER Press Ctrl+Shift
+C to open the Catalog Manager
dialog box.

Select one of the catalog options:

◆ Catalogs Accessible by All
Users. Creates a catalog for all
users.

◆ Catalogs Accessible by the
Current User. Creates a catalog
for only the current user.

◆ Custom Location. Creates a
catalog in the specified
location.

Click New.

Type a name for the new catalog.

Select the Import free music into
this catalog check box to include
free music.

Click OK.6
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Open a Catalog

In the Organizer, click the File
menu, and then click Catalog.

Select one of the catalog options
to display the catalog you want to
open:

◆ Catalogs Accessible by All
Users. Displays catalogs for all
users.

◆ Catalogs Accessible by the
Current User. Displays catalogs
for only the current user.

◆ Custom Location. Displays
catalogs in the specified
location.

Select the catalog you want to
open from the list. 

Click Open.4

3

2

1

Did You Know?
You can convert a catalog to another
type. Click the File menu, click Catalog,
click Convert, select a catalog to con-
vert, and then click Convert. If a cata-
log is not available, click Find More
Catalogs to select a catalog folder
location. When you’re finished, click
Done.

43
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The Catalog Manager makes it easy to work with the different catalogs
you may have on your computer. In the Catalog Manager, catalogs are
organized in different ways: accessible by all users, accessible by the
current user, and custom location. When you select one of these
options, the catalogs related with the option appear below in the list.
After you select a catalog, you can use the buttons in the Catalog
Manager to rename, move, remove, optimize (re-builds data for effi-
ciency), and repair (corrects structure errors) it for better use. 

Managing Catalogs

Manage Catalogs

In the Organizer, click the File
menu, and then click Catalog.

Select one of the catalog options:

◆ Catalogs Accessible by All
Users. Displays catalogs for all
users.

◆ Catalogs Accessible by the
Current User. Displays catalogs
for only the current user.

◆ Custom Location. Displays
catalogs in the specified
location.

Select one of the catalog options:

◆ Rename. Click Rename, type a
name, and then click OK.

◆ Move. Click Move, select a
catalog option to switch to, 
and then click OK.

◆ Remove. Click Remove, and
then click Yes to confirm.

◆ Optimize. Click Optimize to
optimize the catalog, and then
click OK upon completion.

◆ Repair. Click Repair to repair
the catalog. If no problems,
click OK or Repair Anyway.

◆ Convert. Click Convert to
convert catalogs with previous
versions of Photoshop
Elements.

Click Cancel.4

3

2

1

4

3

2

For Your Information

Upgrading Catalogs to Photoshop Elements 6

When you start Photoshop Elements 6 for the first time, it may not
automatically open the catalog from an earlier version of Photoshop
Elements or Photoshop Album. If this happens, click Convert in the
Catalog Manager dialog box, select the Show Previous Converted
Catalogs check box to show converted or backed up catalogs from
earlier versions, select your catalog, such as My Catalog, (use the
Find More Catalogs button if needed), click Convert, click Done, select
the catalog, and then click OK. Photoshop Elements 6 lets you view
and edit the following: PSE 5.0 (all creations), PSE 4.0 (slide shows
only), PSE 3.0 (no creations), or Photoshop Albums (no creations).
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Because the photos and other media files in the Organizer are links to
the actual files, if you move the files on your computer, the Organizer
will lose the link location and need to reconnect to it. Instead of moving
files in an Explorer window, you should move files in the Organizer
using the Move command on the File menu. The Move command
updates the links in the catalog, so links are not lost.

Moving Files in a
Catalog

Move Files in a Catalog

In the Organizer, select one or
more files you want to move.

Click the File menu, and then click
Move.

TIMESAVER Press Ctrl+Shift
+V to move files in a catalog.

Click Browse.

Navigate to the new location for
the files, select the folder, and
then click OK.

If you want to remove files from
the catalog, select them, and then
click the Remove button.

If you want to add files from the
catalog, click the Add button, use
the Add Photos dialog box to
select the photos you want, click
Add Selected Photos, and then
click Done.

Click OK.7

6

5

4

3

2

1

Did You Know?
You can duplicate a file in the catalog
In the Organizer (Photo Browser), elect
a file you want to duplicate, click the
File menu, click Duplicate. The file
name is appended with “-copy.” 

7

3

6 5

Click to add
selected photos

Select check boxes
to add photos

Select options to display photos
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If you no longer use or want to have a file in the catalog, you can
delete it. You have the choice to delete the file from the catalog and
leave the original file on your computer, or delete them both. When you
delete the original file, it’s permanently removed from your computer,
which you cannot undo.

Deleting Files from 
a Catalog

Delete Files from a Catalog

In the Organizer, select one or
more files in the Photo Browser or
one file in Date view you want to
remove.

Click the Edit menu, and then click
Delete from Catalog or Delete
Selected Items from Catalog.

If you want to delete the files from
your computer, select the Also
delete selected item(s) from the
hard disk check box.

Click OK.

If prompted to delete projects,
click Yes or No.

5

4

3

2

1

Did You Know?
You can rename a file in the catalog
Select a file in the Photo Browser,
click the File menu, click Rename, type
a name, and then click OK. 

You can also rename a batch of files,
which renames all the files with the
name of the first file and adds a num-
ber at the end in successive order. To
rename a batch of files, select the files
you want to rename in the Photo
Browser, click the File menu, click
Rename, type a name for the common
base, and then click OK. 

1 2

3 4
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After you have worked with photos and media files in the Organizer for
a while, it’s important to backup the catalog, so you don’t lose any
information if you have problems with your computer. You can backup
the currently opened catalog to a CD, DVD, or hard drive location.
Photoshop Elements uses a wizard to make it easy to perform a
backup.

Backing Up a Catalog

Back Up a Catalog

In the Organizer, open the catalog
you want to backup.

◆ If prompted, click Reconnect to
locate missing or moved files.

Click the File menu, and then click
Backup Catalog to CD, DVD or
Hard Drive.

TIMESAVER Press Ctrl+B to
backup a catalog.

On first use, click the Full Backup
option. If you have already
performed a full backup, click the
Incremental Backup option.

Click Next.

Select a destination drive.

Specify any of the following
options that apply to the selected
destination:

◆ Name. Specify a backup name.

◆ Write Speed. Select a speed to
write a CD or DVD.

◆ Backup Path. Click Browse to
select a location.

◆ Previous Backup File. Click
Browse to select a file.

Click Done to perform the backup.

Click OK upon completion.8

7

6

5

4

3

2

1

4

3

7

5

6
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After you have backed up a catalog, you can restore it at any time.
Before you can restore a catalog backup, you need to select the
backup file with the .tly extension you want to restore from the location
where you stored it. You can restore a catalog backup in the original
location to replace the current one or in a new location. 

Restoring a Catalog
Backup

Restore a Catalog Backup

In the Organizer, open the catalog
you want to backup.

Click the File menu, and then click
Restore Catalog from CD, DVD or
Hard Drive.

Select the location with the
backup catalog you want to
restore:

◆ CD/DVD. Click the CD/DVD
option, click the Select Drive
list arrow, and then select a CD
or DVD drive.

◆ Hard drive. Click the Hard
drive/Other Volume option,
click Browse, navigate to the
folder with the catalog backup,
select the catalog backup file
(with the .tly extension), and
then click Open.

Select the location where you
want to restore the backup
catalog:

◆ Original Location. Click to
restore the catalog backup to
the original location replacing
the current catalog.

◆ New Location. Click to specify
a new location to restore the
catalog backup. Click Browse
to select a folder. Select the
Restore Original Folder
Structure check box. 

Click Restore.

Click OK upon completion.6

5

4

3

2

1

5

4

3

Catalog backup file
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Index

A
ABR files, 497
absolute colorimetric rendering intent, 459
Accented Edges filter, 361
activating program, 2-3
Activity, sorting content by, 337
Actual Pixels command, 157
actual size, displaying photos in, 75
adaptive colors

for GIF documents, 392
for PNG-8 documents, 394

Additive RGB, 239
Add Noise filter, 358
Add to Selection tool, 189
Adjust Color Curve dialog box, 256
Adjust Color for Skin Tone command, 261
adjustment layers, 205

blending modes with, 230
confining effects of, 207
content, changing, 227
creating, 214, 225
deleting, 229
Levels adjustment, application of, 252
masks, 234
filters with, 235
merging, 232
modifying, 228
opacity for, 230-231
regular layer, converting to, 229
temporary composite image, 

creating, 233
using, 224

Adjust Organize Bin Size button, 10
Adjust Sharpness filter, 280
Adobe Acrobat. See PDF format
Adobe Bridge, 4
Adobe E-mail Service, 40

Adobe Help Center, 4, 20
Adobe Idea Gallery page, 19
Adobe Illustrator images, inserting, 131
Adobe Partner Services preferences, 38-39
Adobe Photo Downloader (APD) dialog 

box, 32-33
importing photos with, 50-51
mobile phone preferences, setting, 37

Adobe Photoshop CS3 photo projects, 
editing, 445

Adobe Photoshop Elements 6 product
page, 19

Adobe Photoshop Services, 410
online gallery, publishing, 419
photo book, ordering, 412
photo calendar, ordering, 414
Sharing Center, 462

Adobe Premier Elements, publishing slide
shows to, 432

Adobe Reader software. See PDF format
Adobe Stock Photo, 145
Adobe Updater, 22-23
Adobe Updater Preferences dialog 

box, 4, 22-23
Adobe web site

accessing information from, 19
keyboard shortcut information, down-

loading, 16-17
LiveDocs Help, 20-21

Airbrush button with Dodge and Burn 
tools, 285

Airbrush tool, 302
albums

adding photos to, 103
creating, 101
deleting

groups, 107
photos from albums, 103

displaying photos in, 106
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albums (continued)
editing, 101

album groups, 102
smart albums, 104-105

groups
adding photos to, 103
creating, 102
deleting, 107
working with, 106-107

importing/exporting album structure, 107
merging, 107
name of smart album, editing, 105
preferences, setting, 36
reordering photos in, 106-107
smart albums

creating, 104
editing, 104-105

sorting photos in, 106
Albums palette, 10. See also albums

working with, 100
alignment

with Clone Stamp tool, 284
with Pattern Stamp tool, 309
with Photomerge Faces, 436
with Photomerge Group Shot, 439
of selections, 202
for slide show text, 431
of text, 368

all version sets, searching for, 92
Ambiance slider, Lighting Effects filter, 353
anchor points

with Magnetic Lasso tool, 183
with 3D Transform filter, 271

angles
with Background Eraser tool, 311
Brush tool, setting with, 303

animated GIFs, 393, 398-399
background colors for, 394

animation. See also animated GIFs
Flash animation, PNG-8 format and, 394
in online gallery, 418, 420-421

anti-aliasing
with Color Replacement tool, 316
Column Marquee tools and, 179
and Lasso Marquee tool, 180-181
with Magic Eraser tool, 312
with Magic Wand tool, 186

and Magnetic Lasso tool, 182
with Paint Bucket tool, 308
and Polygonal Lasso tool, 184
for text, 368-369, 372
with 3D Transform filter, 270

APD dialog box. See Adobe Photo
Downloader (APD) dialog box

Application dither, 386
application names, 31
Apply Pixel Aspect Ratio To Preview check

box, 128
Arch text style, 370
Arc styles for text, 370
arranging selections, 202
arrowheads with Line tool, 319
ASF format for video, 54
Asian text

options, 493
working with, 367

Assign Profile command, 458
attaching keyword tags to photos, 87-88
attachments, sending files as, 463
audio. See also slide shows

full Screen View Options dialog box
options, 73

music, Full Screen View Options dialog
box options, 73

notes, audio, 176
Photo Browser, displaying files in, 68
soundtracks for slide shows, 425

Auto Color tool, 109, 250
Auto Contrast tool, 111
Auto Erase feature, 304, 305
Auto Levels tool, 110
Automatic Lighting command, 250
Auto Red Eye Fix command, 113, 289
Auto Select Layer option, 202, 208
Auto Sharpen tool, 112
Auto Smart Fix tool, 108
Average Blur filter, 354
Avery label sheets, 450-451
AVI format for video, 54

B
Background Brush tool, 189
background colors, 292-293

for animated GIFs, 394
Auto Erase feature and, 305
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Background Eraser tool, 310-311
defaults and switching to, 293
with Pencil tool, 304
printing, 456
for slide shows, 424

Background Eraser tool, 310-311
Backgrounds, 205, 338-339

converting into layer, 212-213
moving, 216
multi-layered documents into back-

ground, converting, 213
for new files, 126
shape layers for, 317

Background styles, 337
backing up

catalogs, 61
files, prompting for, 28

banners, adding, 338
barrel distortion, 278-279
baseline for photos for Web, 405
beep preferences, 476
Bevel layer style, 324

changing settings, 330-331
for chiseled type, 376-377

Bevel Size or Direction option for layer
styles, 324

Bicubic Sharper method, 138
bins. See Project Bin
bit depth, 238
bitmapped fonts, 358, 369
bitmaps, 127

converting image to, 241
black and white. See also grayscale

adjustment layers for, 225
for camera raw images, 132
Convert to Black and White 

adjustment, 266
Levels adjustment, application of, 253
Threshold adjustment, 265

blemishes, touching up, 143
blending modes, 204

with adjustment layers, 230
with basic Eraser tool, 310
with Blur tool, 283
with Brush tool, 302
with fill layers, 230
and filter effects, 348
for gradients, 313

with Impressionist tool, 306
with Paint Bucket tool, 308
with Pencil tool, 304
selecting, 207
with Sharpen tool, 281
with Smudge tool, 307
working with, 222

Blizzard effect, 335
bloat option, Liquify filter, 350-351
Blur filters, 354-355. See also Gaussian Blur

filter
Smart Blur filter, 354

Blur More filter, 354
Blur tool, 283
blush skin tone, adjusting, 261
BMP files, 149
boldfacing type, 368, 369
Border command, 192
borders

Automatic Color command and, 250
new border, framing selection with, 192
printing, 453, 456
showing/hiding, 65

bounding boxes for selected items, 202
brightness

adjustment layers for, 225
Brightness/Contrast adjustment, 255
for camera raw images, 132
Color dialog box for, 293
correcting, 110
Equalize command for, 264
with Guided Edit, 142
Invert command for, 264
and Magnetic Lasso tool, 182
Photo Filter adjustment, 263
Shadow/Highlight adjustment, 

using, 254
Threshold adjustment and, 265
type masks, working with, 375

Brightness/Contrast adjustment, 255
Browser dither, 386-387
browsers

drawing tablets for, 498
previewing images in, 400-401

brushes. See also Brushes palette; Brush
tools

with Clone Stamp tool, 284
with Liquify tool, 352
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Brushes menu
with Blur tool, 283
with Sharpen tool, 281

Brushes palette
changing view, 295
loading customized brush set, 300-301
renaming brushes, 299
resetting brush sets, 301
resizing, 296
saving customized brush set, 300
tips

cursor option, 487
customized tips, creating, 297
deleting tips, 298-299
loading customized brush 

set, 300-301
modifying existing tip, 298
saving customized brush set, 300
selecting, 296

types of brushes, 294
viewing, 294

Brush tablet, 302
Brush tools, 302

with drawing tablets, 303
dynamic brush options, setting, 303
Magic Extractor, 188-189
options, working with, 17
Selection Brush tool, 187

Bulge text style, 370
burning CDs/DVDs. See CDs/DVDs
Burn tool, 285
buttons, shape layers for, 317

C
cache, allocating, 475, 482-483
Cache Levels, setting, 482
calendar, photo, 414
calligraphy

brushes, calligraphic, 294
with Pencil tool, 304

camera raw
data, opening, 132-133
file formats, 149
saving preferences, setting, 479

cameras. See digital cameras
canceling actions, 18
canvas size, changing, 138-139

captions
Date view, adding in, 76-77
Find menu, searching in, 92
Full Screen View Options dialog box

options, 73
for online gallery photos, 420-421
in photo book, 412
for photo mail, 464
printing, 456
for slide shows, 425

card readers
importing photos from, 50-51
preferences, setting, 32

Cascade command, 162-163
Catalog Manager, 56

working with, 58
catalogs

backing up, 61
converting, 57
deleting, 58

files from catalog, 60
files in catalog

deleting, 60
duplicate, 59
moving, 59
renaming, 60

managing, 58
moving files in catalog, 59
new catalog, creating, 56
opening, 56-57
restoring catalog backup, 62
updating/upgrading from previous 

versions, 58
categories. See also Keyword Tags palette

attaching information to file, 144-145
CCITT files, 151
CDs/DVDs

catalogs, backing up, 61
files in Elements, creating CDs/DVDs 

for, 468
importing photos from, 49
jackets, creating, 416
labels, creating, 416
multisession burning, enabling, 29
online gallery, burning, 419, 421
Sharing Center, 462
slide shows, publishing, 432-433
VCD with menu of slide shows, 434-435
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cell phones. See mobile phones
centering document windows, 477
centimeters option for printing, 449
channels in Levels adjustment, 253
Chinese text

options, 493
working with, 367

chiseled type, 333
type mask, creating with, 376-377

circles
creating, 320-321
with Elliptical Marquee tool, 179

Clear Undo History option, 169
clipart

slide shows, adding to, 430
Web, preparing clipart for, 402-403

Clipboard
clearing contents of, 172
General preferences for, 476
selections, copying and pasting, 200

clipping
Color Variations adjustment and, 259
groups, creating, 223

Clone Stamp tool, 284
Clone tool

for camera raw images, 132
for raw images, 133

Close button, 8
closing

files, 152
open photos, 134

CMYK (Cyan, Magenta, Yellow, Black), 238
Info palette, changing measurement 

by, 166
collages, photo, 415
collapsing. See expanding/collapsing
Color Cast Eyedropper tool, 143
Color Curves adjustment, 256
color depth, 238
Color dialog box, selecting colors with, 293
Color Halftone Pixelate filter, 349
color lookup table (CLUT), 242-243
color markers, creating, 165
color modes, 237. See also CMYK (Cyan,

Magenta, Yellow, Black); grayscale;
indexed color; RGB (Red, Green,
Blue)

for animated GIFs, 394

Info palette, changing measurement 
by, 166

for new files, 126
selecting, 127
switching between, 238
working with, 238

color profile, Status bar information, 173
Color Replacement tool, 316
colors. See also background colors; fill 

layers; foreground colors; Histogram
palette; Info palette; printing; 
reduction method for colors

adjustment layers for, 225
Auto Color tool, 109, 250
for camera raw images, 132
with Custom Shape tool, 322
for Drop Shadow layer style, 329
Equalize command, 264
filter colors, changing, 346
for GIF documents, 392
Gradient Map adjustment and, 262
gradients, color stops with, 315
for grids, 490
with Guided Edit, 142-143
Hue/Saturation adjustment, 257
Invert command, 264
layers, color-coding, 207
with Line tool, 319
Navigator palette view box, changing

color of, 156
Photo Filter adjustment, 263
Posterize adjustment, 265
Quick Edit, adjusting with, 141
Remove Color Cast adjustment, 260
remove all color, 260
removing pixels from color 

selection, 192-193
Replace Color adjustment, 258
of shapes in layer, 317
shield color, setting, 486
similar color to selection, adding, 193
skin tone, adjusting color for, 261
sorting content by, 337
with Standard Shape tool, 320
Stroke layer styles settings, 334
strokes, creating, 248
for text, 369
text color, changing, 365



532

Color Sample tool, 133
Colors palette. See also colors

for clipart, 403
Color Swatches palette

changing display, 245
choosing color swatch in, 244-245
custom color swatches, creating, 246-247
loading, 247
saving customized colors, 247

Color Variations adjustment, 259
Column Marquee tools, 179
column size settings, 489-490
commands, choosing, 8
Complex layer style, 324
composite image, creating, 233
compression, 150-151. See also JPEG 

format; lossless compression; lossy
compression

CompuServe GIFs, 149
concavity with Line tool, 319
contact book, 466-467

groups, creating
contact sheets, printing, 451
Content palette, 337. See also Backgrounds;

styles
photo book designs, 412-413
photo collage designs, 415
shapes in, 338
Sort list arrow, 337
text, adding, 337, 340
themes in, 337, 340

context menus, 8
Contract command, 192. See also

expanding/collapsing
contrast

adjustment layers for, 225
with Black and White adjustment, 266
Brightness/Contrast adjustment, 255
for camera raw images, 132
Color Curves adjustment and, 256
with Guided Edit, 142
improving, 111
Quick Edit, adjusting with, 141
with Refine Edge tool, 190
with Shadow/Highlight adjustment, 254

Control bar, 75
converting 

bitmap color mode, 241

grayscale color mode, 240
indexed color mode, 242-243
multiple files, 137
non-supported files, 239
RGB color mode, 239

Cookie Cutter tool, 273
copy, saving file as, 146
Copy command, 200-201
copying. See also layers

files to disk, 471
selections, 200-201
style settings between layers, 326-327
Vanishing Point tool, 442

Copy Merge command, 201
copyrights

attaching information to file, 144-145
Digimarc watermarks displaying, 28-29

Correct Camera Distortion filter, 278-279
correcting photos. See colors; fixing photos
Create New Layer button, 221
Crop command, 274-275
Crop Photo dialog box, 114
cropping

camera raw images, 133
with Cookie Cutter tool, 273
focus and, 195
with Guided Edit, 142
labels on printing, 451
photos, 114
scanned photos, 274-275
selections, 194-195
for slide shows, 425
with user-defined shape, 195

Cube tool with 3D Transform filter, 270
cursor preference, setting, 486-487
curves, Color Curves adjustment, 256
Custom Shape tool, 322

cropping with, 195
Cutout filter, 348, 360
Cylinder tool with 3D Transform filter, 270
cylindrical panoramas, 441

D
dates and times

changing, 122
findings photos with, 93
time zone, adjusting times for, 122
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Date view
events, adding, 76-77
in Photo Browser, 64
preferences, setting, 35
viewing photos in, 76-77

defaults
background colors, switching to, 293
foreground colors, switching to, 293
libraries, resetting, 497
palettes, resetting, 15, 485
preferences, restoring, 477

definitions, finding, 21
defringing colors, 189
deleting. See also albums; catalogs; layers

adjustment layers, 229
Albums palette, 100
audio annotations, 176
brush tips, 298-299
Color Swatches palette, colors from, 246
contact book entry, 466
with Control bar, 75
fill layers, 229
Folder Location view, deleting folders 

in, 66-67
fringe colors, 189
keyword tags, 89
library items, 496
notes, 175
pins in Map view, 79
selections, saved, 198
slide shows, slides from, 426
stack, photos from, 118-119
text, 365
Undo History palette items, 169
version set, photos from, 120-121
watched folders list, removing folders 

to, 42-43
Desaturate command, 257
Deselect command, 71
desktop wallpaper, using photos as, 472
Despeckle Noise filter, 357
dialog boxes, showing/hiding, 26
diameter with Background Eraser tool, 311
Difference blending mode, 230
Diffuse Glow filter, 361
diffusion dither for bitmap images, 241
Digimarc Corporation, 345

copyright information, watermarks in,
28-29

digital cameras
attaching information to file, 144-145
importing photos from, 50-51
noise from, 359
opening raw files, 132-133
preferences, setting, 32-33

digital projects, 409. See also online gallery;
slide shows

saving, 411
digital watermarks, 345
Display & Cursors preferences, 486-487
displaying

open photos, 134
options, setting, 486

distance settings for Bevel layer style, 331
distortion

Correct Camera Distortion filter, 278-279
Transform command, Distort option, 269

distribution of selections, 202
dithering

adjusting dither, 386
for bitmap images, 242
clipart, options for, 403
and Color Halftone Pixelate filter, 349
in GIF documents, 393
in Gradient Map adjustment, 262
for gradients, 313
for indexed color, 243
and PNG-8 format, 386, 394
previewing dither, 387

Divide Scanned Photos command, 274
DNG files, raw images as, 132
docking/undocking palettes, 14-15
documents. See also Web documents

layers between documents, moving, 164
printing, 460
Status bar, using, 173
transparency preferences, 

controlling, 492
document windows. See windows
Dodge tool, 285
Don't Show Again check box, 26
downloading. See also Adobe Photo

Downloader (APD) dialog box; Adobe
web site

estimating download time, 401
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downloading (continued)
keyboard shortcut information, 16-17
updates, 22-23
video software, 54

drag-and-drop
layers between documents, 164
in Navigator palette, 154

drawing tablets
Brush tool options for, 303
using, 498

Drop Shadow layer style, 324
changing settings, 328-329

drop shadows, 335. See also Drop Shadow
layer style

brushes, 294
for slide show text, 431

dry media brushes, 294
duplicating

files in a catalog, 59
layers, 221
open photos, 135

dust, removing, 358
Dust and Scratches filter, 358
DVDs. See CDs/DVDs
dynamic brush options, setting, 303

E
editing. See also albums

contact book entry, 466
Keyword tags categories, 84-85
layer styles, 324, 326-327
options, setting, 31
slide shows, 427
stacks, photos in, 119
text layers, type in, 366
version sets, photos in, 121

Editor, 129. See also Full Edit; Guided Edit;
Info palette; Palette Bin; printing;
Project Bin; tools

adding photos to Organizer from, 56
animated GIFs, opening, 399
attaching/detaching palettes, 14
commands in, 8
exiting, 24
Options bar, working with, 17
Organizer, switching to, 9
Plug-Ins preferences, 494-495

Quick edit, 140-141
Sharing Center, accessing, 462
video, capturing photos from, 54
viewing workspace, 7

Editor button, 9
effects. See also photo effects

slide shows, adding to, 428-429
Effects palette

Layer Styles button, 325
Photo Effects button, 335

efficiency, Status bar information, 173
ellipses, creating, 320-321
Elliptical Marquee tool, 179
e-mail

contact book, 466-467
files in e-mail, sending, 463
finding photos by, 93
online gallery, e-mail address 

for, 420-421
Sharing Center, 462
sharing preferences, setting, 40

embedding digital watermarks, 345
Emboss layer style for chiseled 

type, 376-377
EPS format, 149

inserting images in, 131
metadata information, adding, 145
opening, 129
for text, 365

Epson printers, 451
Equalize command, 264
Eraser tools, 310-311

Auto Erase feature, 304, 305
Background Eraser tool, 310-311
basic Eraser tool, 310
Magic Eraser tool, 312
with Photomerge Faces, 436
with Photomerge Group Shot, 438-439

errors in multiple files, recording, 137
eSeminars, links to, 19
events

Date view, adding events in, 76-77
sorting content by, 337

Events category, Keyword Tags palette, 82
excluding photos from search, 91
Exclusion blending mode, 230
EXIF format, 28-29

printing and, 451
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saving preferences, setting, 479
exiting Photoshop Elements, 24
Expand command, 192
expanding/collapsing

Albums palette, 100
existing selection, 192
in Folder Location view, 66-67
Keyword Tags palette, 82
notes, 175
open photos, 134
palettes, 12-13
with Refine Edge tool, 190

exporting. See importing/exporting
exposure

for camera raw images, 132
correcting, 110
Shadow/Highlight adjustment, 

using, 254
Exposure slider, Lighting Effects filter, 353
Eyedropper tool, 292

color markers, creating, 165
with mattes, 385
with Save for the Web command, 382

Eye icon, 214

F
faces

combining, 143
keyword tags, finding by, 86

Faded Photo effect, 335, 336
fades

Brush tool, setting with, 303
Full Screen View Options dialog box

options, 73
options, setting, 26-27

faux finish brushes, 294
faux option for fonts, 368
favorites list

layer styles, adding, 342
photo effects, adding, 342

feathering
with Cookie Cutter tool, 273
existing selection, 191
with Refine Edge tool, 190

50% threshold for bitmap images, 241
File Association Manager, 480
File compatibility options, 478-479

file extensions, 147
for projects, 411

file formats, 149. See also specific types
File Info dialog box, 28
filenames

Find menu, searching in, 92
for open photos, 135
printing, 456

File options, modifying, 28-29
files. See also catalogs; filenames; sending

files
associations, setting, 480
attaching information to, 144-145
CDs/DVDs with files, creating, 468
closing, 152
copy to disk, 471
importing photos from, 46-47
inserting images in, 131
keyword tag information, writing, 95
move to disk, 471
multiple files, working with, 136-137
new file, creating, 126
opening files, 129-130
for panoramas, 440
presets, creating files with, 128
resizing, 138-139
saving, 146-147
showing/hiding file names, 65
working with, 134-135

Fill Layer command, 248-249
fill layers, 205

blending modes with, 230
content, changing, 227
creating, 214, 226, 248-249
deleting, 229
merging, 232
modifying, 228
using, 224

fill light for camera raw images, 132
Fillmstrip icon, 70
Fill Pixels button, 322
Filter Gallery, 344-345. See also filters

categories of filters, 344
filters, 346
Layers palette in, 345

Filter Gallery dialog box, 344-345
filters

Add Noise filter, 358
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filters (continued)
and adjustment layers, 225, 235
Adjust Sharpness filter, 280
blending modes and, 348
categories of, 344
Color Halftone Pixelate filter, 349
colors of filters, changing, 346
Correct Camera Distortion filter, 278-279
Despeckle Noise filter, 357
Dust and Scratches filter, 358
keyboard shortcut for applying, 345
Lighting Effects filter, 353
Liquify filter, 350-352
multiple filters, applying, 346
Photo Filter adjustment, 263
for photographic restoration, 358
Reduce Noise filter, 359
selection tools with, 347
star rating filters, 97
3D Transform filter, 270-271
Unsharp Mask filter, 282
viewing various effects, 360-362

Find bar
Organizer, 6
searching for photos with, 91
star rating filter on, 97

Find by Details (Metadata) dialog box, 94-95
Find Edges filter, 348
Find Faces for Tagging button, 86
finding. See searching
finger painting with Smudge tool, 307
FireWire

drives, 475
for Video Preview option, 128

Fisheye text style, 370
Fish text style, 370
Fit on Screen command, 157
fitting photos on screen, 75
Fixed Aspect Ratio, 178

with Elliptical Marquee tool, 179
Fixed Size with Elliptical Marquee tool, 179
fixing photos. See also colors; red eye

reduction
Auto Smart Fix tool, 108
contrast, improving, 111
exposure, fixing, 110
sharpening photos, 112

Flag text style, 370

Flash animation, PNG-8 format and, 394
flattening, 212-213

fill or adjustment layers, 232
multi-layered documents, 213

flipbooks, creating, 422
flipping, 276-277

printing, flipping image for, 456
FLM format, 149
FLV format for online gallery, 418
focus, cropping for, 195
Folder Location view, 64

keyword tags, attaching, 88
preferences, setting, 30
viewing photos in, 66-67

folders
importing photos from, 46-47
keyword tags with folder names, 

creating/attaching, 88
for panoramas, 440
slide shows, adding content to, 426
watched folders, specifying, 42-43

fonts
English, showing names in, 493
preferences, setting, 493
for slide show text, 431
for type masks, 372
working with, 368-369

forced option for indexed color, 242
Foreground Brush tool, 189
foreground colors, 292-293

Auto Erase feature and, 305
with Color Replacement tool, 316
defaults and switching to, 293
with Paint Bucket tool, 308
with Pencil tool, 304

Frame From Video dialog box, 54
Frame photo effects, 335, 336
frames

in animated GIFs, 394
animated GIFs, delay with, 399
in Content palette, 340
normal image layer, converting to, 211
for printing labels, 451-452
shape layers for, 317

Frames styles, 337
Free Rotate Selection command, 276-277
Free Transform command, 268-269
Fresco filter, 360
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fringe colors, removing, 189
From Mobile Phone command, 53
F-Stop information, attaching, 144-145
Full Backup option for catalogs, 61
Full Edit, 7, 9

version sets in, 120
working with, 140

Full Screen view
Control bar in, 75
Side by Side view, viewing photos in, 74
viewing photos in, 72-73

Full Screen View Options dialog box, 72-73
Fuzziness slider, Replace Color 

command, 258

G
Gaussian Blur filter, 354

with adjustment layer masks, 235
Adjust Sharpness filter and, 280
selection tools with, 347
using, 356

general preferences, setting, 476-477
Geometry list arrow

with Custom Shape tool, 322
with Line tool, 319
with Standard Shape tool, 320

Get Photos from Files and Folders dialog
box, 46-47

GIF format
animated GIFs, 393, 398-399
Application dither in, 386
Browser dither in, 386
clipart, preparing, 402-403
compression of, 150-151
CompuServe GIFs, 149
file size, optimizing image to, 397
matted images in, 385
metadata information, adding, 145
opening, 129
optimizing GIF documents, 392-393
with Save for the Web 

command, 380, 382
transparency options, 384, 393
working with, 388-389

Glass Buttons layer style, 324
Glass filter, 361

Gloss slider, Lighting Effects filter, 353
Glowing Edges filter, 361
glyph protection, 493
Gradient Map

adjustment, 262
adjustment layers for, 225

gradients
custom gradients, creating, 314-315
fill layers for, 226
normal image layer, converting to, 211
standard gradient, creating, 313
text, applying gradient fill to, 378

Gradient tool, 313
shortcut key for, 16
text, applying gradient fill to, 378

Grain filter, 362
Graphic Pen filter, 362
graphics. See also clipart; photos

Content palette, adding graphics 
from, 338

styles, 337
grayscale, 127

colorizing images, 240
converting image to, 240
Convert to Black and White 

adjustment, 266
Desaturate command for, 257
Invert command for, 264
for new files, 126
remove all color, 260
Video Preview option supporting, 128

greeting cards, creating, 417
grid lines

options, setting, 490
showing/hiding, 65
Snap To option for, 490-491

groups. See albums; layers
group shots, combining people in, 143
growing selection, 191
Guided Edit, 7, 9

working with, 142-143
guides, working with, 174
gutters, setting, 489-490
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H
halftones. See also dithering

bitmap images, screen for, 241
Color Halftone Pixelate filter, 349

Hand tool
with Correct Camera Distortion filter, 278
Document window, moving images 

in, 161
with Liquify filter, 351
for raw images, 133
with Save for the Web command, 382
with 3D Transform filter, 270

Hard Mix blending mode, 230
hardness

with Background Eraser tool, 311
Brush tool, setting with, 303

headers
IPTC Keyword section of, 95
for palettes, 12

Healing Brush, 143, 287
Heal tool

for camera raw images, 132
for raw images, 133

height/width. See also rulers
column size settings, 489-490
with Line tool, 319
multiple files, changing width/height 

for, 137
for new files, 126
printing options, 454-455
with Scale commands, 272
Status bar information, 173

help. See also Adobe web site
updates, checking for, 23

hidden, marking photos as, 68-69
hiding. See showing/hiding
highlights

camera raw images, recovery for, 132
Color Curves adjustment and, 256
Color Variations adjustment and, 259
with Dodge and Burn tools, 285
with Guided Edit, 142
Levels adjustment, application of, 253
Quick Edit, adjusting with, 141
for selected items, 202
Shadow/Highlight adjustment, 

using, 254

Histogram palette
Levels adjustment in, 252-253
working with, 251

histograms for raw images, 133
history. See also Undo History palette

attaching information to file, 144-145
revert action added to, 148

History States, 474
number, setting, 484
setting, 482

holes in selection, filling, 189
Horizontal Type Mask tool, 372

for chiseled type, 376-377
isolating image pixels with, 374-375

HTML files
creating, 389
previewing images, 400

hue
adjustment layers for, 225
Brush tool, setting hue jitter with, 303
Color dialog box for, 293
Hue/Saturation adjustment, 257

I
I-beam cursor, 486
IBM PC printers, preparing images for, 407
ICC profile

embedding, 147
in JPEG documents, 391
projects, saving in, 411

icons
Eye icon, 214
Fillmstrip icon, 70
starburst icon, 324

Image Effects, 335
layer style, 324

image layer, converting layer to, 211
Imported Batch view, 64
Imported on, finding photos by, 93
importing/exporting

album structure, 107
card reader, photos from, 50-51
CDs/DVDs, importing photos from, 49
to contact book, 466
digital cameras, photos from, 50-51
from Editor to Organizer, 56
EXIF captions, importing, 28
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files and folders, importing photos 
from, 46-47

flipbooks, 422
keyword tags, 44-45, 87
mobile phones, importing photos 

from, 52
to Organizer from Editor, 56
photos as files, exporting, 470
scanners, importing photos from, 52

Impressionist Brush tool, 306
Impressionist option, Pattern Stamp 

tool, 309
inches option for printing, 449
InDesign, preserving text for, 365
indexed color, 127, 238

clipart, options for, 403
converting image to, 242-243
predefined indexed color table, 

using, 243
Video Preview option supporting, 128

Inflate text style, 370
Info palette

color markers, creating, 165
measurement of color, changing, 166
specific sized object, creating, 165
working with, 165

inkjet printers
preparing image for, 406-407
resolution, 408

Inner Glow layer style, 324
changing settings, 332-333

Inner Shadow layer style, 329
installing Photoshop Elements, 2-3
Instant Keyword Tag button, 88
intellectual property, digital watermarks 

for, 345
interactive online gallery, 

creating, 418, 420-421
interactive panoramas, 441
interlaced option

for GIF documents, 393
PNG-24 image, loading of, 396

Internet. See also Adobe web site; online
gallery; Save for the Web command;
Web documents

updates, checking for, 22-23
interpolation, 138-139
intersection with selection, replacing saved

selection with, 197, 199

Invert command, 264
IPTC information

attaching information to file, 144-145
header, Keyword section of, 95

italicizing type, 368, 369

J
jackets for CDs/DVDs, creating, 416
Japanese text

options, 493
working with, 367

JPEG format, 149
Browser dither in, 386
camera raw images as, 132
compression of, 150-151
exporting photos in, 470
file size, optimizing image to, 397
ICC color profile, embedding, 391
mattes in, 385, 390
metadata information, adding, 145
opening, 129
optimizing JPEG document, 390-391
for photos for Web, 404
printers, preparing images for, 407
progressive scans, loading JPEG in, 391
Reduce Noise filter, removing artifacts

with, 359
rotating JPEGs with Orientation

Metadata, 29
with Save for the Web 

command, 380, 382
working with, 388-389

JPEG 2000 format, 405

K
keyboard shortcuts

filters, reapplying, 345
for starting Photoshop Elements, 4
for tools, 16, 477
tools, toggling between, 487
with Type tools, 364
for Undo command, 170-171
Undo/Redo shortcut, changing, 485
for zooming in/out, 159

keyword tags, 82
attaching tags to photos, 87-88
creating, 83
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keyboard tags (continued)
custom tags, importing, 44-45
deleting, 89
Folder Location view, tagging files 

in, 66-67
folder names, creating/attaching tags

using, 88
Group Custom Name, creating, 32
importing tags, 44-45, 87
searching for photos by, 90
setting, 36
writing tag information into files, 95

Keyword Tags palette, 10. See also keyword
tags

categories
editing, 84-85
sub-category, changing tags to, 89
working with, 84-85

deleting tags from photos, 89
editing categories/sub-categories, 84-85
faces for keyword tags, finding, 86
folder names, creating/attaching tags

using, 88
imported tags in, 44
searching for photos by tags, 90
sub-categories

changing tags to, 89
working with, 84-85

working with, 82
Kodak EasyShare Gallery

photo calendar, ordering, 414
preferences, setting, 38-39

Korean text
options, 493
working with, 367

L
labels. See also printing

creating, 416
for multiple files, 137

landscape orientation, 448, 454
laser printer, preparing image for, 406-407
Lasso Marquee tool, 180-181
Lasso tools, 180-181

Lasso Marquee tool, 180-181
Magnetic Lasso tool, 182-183
Polygonal Lasso tool, 184
saving selections, 196-197

last saved version, reverting to, 148
launching Photoshop Elements, 4
layer groups, 207

clipping groups, creating, 223
normal image layer, converting to, 211

Layer Mask option, Elliptical Marquee tool
with, 179

layers, 203. See also adjustment layers;
Backgrounds; blending modes; layer
styles; masks; opacity; photo effects;
shape layers; stacking order; text 
layers

active document, adding layers to, 206
for animated GIFs, 394
Background Eraser tool with, 311
clipping groups, creating, 223
color-coding, 207
contiguous layers, selecting, 208
controlling layers, 217
copying

duplicating layers, 221
elements within layers, 210
style settings between layers, 326-327

deleting, 204, 220
adjustment layers, 229
fill layers, 229
layer styles, 326

designations and attributes, 
defining, 205

duplicating, 221
file size and, 207
for gradients, 313
image layer, converting layer to, 211
linking/unlinking, 204, 219

for composite images, 233
deleting linked layers, 220
with Layers palette, 214

locking, 204
with Layers palette, 214-215

merge layer options, 218
moving

adjustment layers, 228
Backgrounds, 216
content of layers, 215, 216
between documents, 164, 217

multiple layers
printing, 461
selecting, 208
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naming, 214
new layers, creating, 204
non-layers, selecting, 208
portions of layer, moving, 217
position of moved layer, controlling, 217
printing multiple layers, 461
project, saving in, 411
reordering, 215
saving files with, 146
selections, 191, 208

layer, creating selection from, 209-210
Layers palette, selecting with, 214
options, 207

showing/hiding, 214
simplifying layers, 211
single layers, selecting, 208
thumbnails, changing, 164, 215

Layers palette, 204. See also layers
deleting layers from, 220
in Filter Gallery, 345
hidden layers, deleting, 220
linking layers, 214-215
naming layers, 214
options, setting, 236
selecting layers with, 214
showing/hiding layers with, 214
thumbnail options, 236
working with, 214-215

Layer Style dialog box, 326
layer styles, 324. See also specific styles

applying, 325
copying settings between 

layers, 326-327
deleting, 326
editing, 324, 326-327
favorites list, adding to, 342
scale, changing, 326-327
showing/hiding, 325

Layer Styles button, 325
leading options for text, 369
length with Line tool, 319
Lens filter, 280
Levels adjustment, Histogram 

palette, 252-253
libraries

default, resetting to, 497
managing, 496-497

lighting. See also brightness; contrast

Automatic Lighting command, 250
Lighting Angle option for layer styles, 324,

328
Lighting Effects filter, 353
Lighting palette with Quick Edit, 141
Linear Light Blending Mode, 348
lines

with Line tool, 319
straight lines, drawing, 304, 305

Line tool, 319
linking/unlinking. See layers
Liquify filter, 350-351

working with options, 352
LiveDocs Help, 20-21
loading/unloading

brush sets, 300-301
Color Swatches palette, 247

locking layers. See layers
Lock transparency button, 215
logos, Custom Shape tool for, 322
looping. See also slide shows

animated GIFs, 399
lossless compression, 150-151

with PNG-24 format, 396
printers, preparing images for, 407

lossy compression, 150-151
for photos for Web, 404

lowercase file extensions. See file
extensions

luminosity. See brightness
LZW files, 151

M
Macintosh

color monitor display, previewing
images in, 401

printers, preparing images for, 407
using Photoshop Elements on, 3

Magic Eraser tool, 312
Magic Extractor, 188-189
Magic Wand tool, 186

saving selections, 196-197
shortcut key for, 16

Magnetic Lasso tool, 182-183
magnifying glass cursor, 486
managed files, 66-67



542

Map view
pinning photos in, 78-79
viewing photos in, 78-79

Map Your Photos with Yahoo Maps dialog
box, 78

margins
measurement options, setting, 489-490
Page Setup options, 448

Marquee tools
for chiseled type, 376-377
Elliptical Marquee tool, 179
isolating image pixels with, 374-375
Lasso Marquee tool, 180-181
Rectangular Marquee tool, 178
saving selections, 196-197
with type masks, 372

masks, 205. See also adjustment layers;
type masks

clipping groups, creating, 223
Elliptical Marquee tool and, 179
selection tools for creating, 235

matching
dates and times, 122
multiple windows, 162-163

Match Location command, 162-163
Match Zoom command, 162-163
Material slider, Lighting Effects filter, 353
matte

clipart, options for, 403
in GIF documents, 393
for indexed color, 243
in JPEG documents, 385, 390
for photos for Web, 405
in PNG-8 format, 394
in PNG-24 format, 396
working with, 384-385

media
finding photos by type, 93
slide shows, adding content to, 426

memory. See also RAM
cache, allocating, 475, 482-483
clearing, 172
100 percent usage, 483

menus
choosing commands from, 8
context menus, 8

Merge Down option, 218
Merge Visible option, 218, 232

merging
adjustment layers, 232
albums, 107
fill layers, 232
layer options, 218
Photomerge Faces, 436-437
Photomerge Group Shot, 438-439
Photomerge Panorama, 440-441

metadata, 6, 28
attaching information to file, 144-145
finding photos by details of, 94-95
XMP Software Development Kit 

with, 145
Microsoft Outlook/Outlook Express

contact book, importing addresses 
to, 466

sharing, 40
Microsoft Windows

color monitor display, previewing
images in, 401

installing Photoshop Elements for, 3
Mail, sharing, 40
Vista, screen saver, creating, 472
Windows XP screen saver, creating, 472

Microsoft Windows Media Center Edition
for flipbooks, 422
slide shows, publishing, 432-433

Microsoft Windows Media Player, 54
viewing photos in, 70

midtones. See also contrast
Color Variations adjustment and, 259
with Dodge and Burn tools, 285
Levels adjustment, application of, 253
with Shadow/Highlight adjustment, 254

Minimize button, 8
Mirror option, Liquify filter, 351
Misc. effects, 335, 336
missing files

reconnecting to, 123
searching for, 28

mobile devices. See also mobile phones
creating files for, 128

mobile phones
flipbooks, exporting, 422
importing photos from, 52
preferences, setting, 37
RGB (Red, Green, Blue) and, 239
sending files to, 465
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Sharing Center, using, 462
Mojikukmi option for Japanese type, 367
M1V format for video, 54
monitors

different color monitors, previewing Web
images in, 400-401

printers, optimizing images for, 407
resolution of, 408
selecting areas for, 178

Monotone Color photo effect, 335, 336
Mood, sorting content by, 337
More button, Undo History panel, 169, 170
More menu, 12-13
Mosaic Tiles filter, 362
Motion Blur filter, 354-355

Adjust Sharpness filter and, 280
Move tool

catalogs, moving files in, 59
with Content palette graphics, 338
copying selections with, 200
lines, repositioning, 319
preferences, setting, 476
for shape layers, 318
shortcut key for, 16

moving. See also layers
adjustment layers, 228
Albums palette, 100
Backgrounds, 216
catalogs, files in, 59
Content palette graphics, 338
Document window, images in, 161
files to disk, 471
Folder Location view, moving files 

in, 66-67
Keyword Tags palette, 82
palettes, 14-15
photo projects, photos in, 444
selections, 202
shapes on layer, 318
slide show, clipart for, 430
with 3D Transform filter, 271
type masks, 374
Vanishing Point tool, 442

MPEG format for video, 54
multi-layered documents into background,

converting, 213
multiple files, working with, 136-137
multiple windows

arranging/matching, 162-163
working in, 162-163

Multiply blending mode, 230
music, Full Screen View Options dialog box

options, 73
My Pictures (XP) folder, 42

N
naming/renaming. See also filenames

application names, 31
brushes, 299
catalogs, 58
files in a catalog, 60
Folder Location view, renaming folders

in, 66-67
layers, 207, 214
library items, 496
multiple files, renaming, 136-137
new files, 126
smart album names, changing, 105

narration to slide show, adding, 431
native formats, 392

PNG-8 format, 394
natural brushes, 294
navigating

with Control bar, 75
Organizer buttons, 6
shape layers for navigation bars, 317

Navigator palette
area of view, changing, 155
color of view box, changing, 156
increasing thumbnail size, 156
size of view, changing, 154
view, changing, 157

Nearest Neighbor method, 138
negative of image, adjustment layers 

for, 225
Neon Glow effect, 335
New Layer Effect button, 346
Newspaper style for Black and White 

adjustment, 266
90 degrees left or right, rotating photos, 115
noise

Add Noise filter, 358
Despeckle Noise filter, 357
digital watermarks as, 345
gradients and, 314
Healing Brush tool and, 287



544

noise (continued)
Reduce Noise filter, 287, 359

Nokia cell phones, recognition of, 53
non-supported files

opening/converting, 239
Note Paper filter, 361
notes

audio notes, 176
Date view, adding in, 76-77
Find menu, searching in, 92
viewing, 175

notification of partner services, 38-39

O
offset print area for labels, 451
Old Photo effect, 335, 336
online gallery, 418-419

animated gallery, creating, 418, 420-421
interactive gallery, creating, 418, 420-421

Online Learning Resources command, 19
online support. See Adobe web site
Online Support command, 19
opacity, 204, 207

for adjustment layers, 230-231
with basic Eraser tool, 310
and blending modes, 348
with Brush tool, 302
display options, setting, 486
for Drop Shadow layer style, 328
for gradients, 313, 315
with Impressionist tool, 306
Inner Glow layer style settings, 333
with Magic Eraser tool, 312
Outer Glow layer style settings, 333
with Paint Bucket tool, 308
with Pencil tool, 304
for slide show text, 431
Stroke layer styles settings, 334

Open As command, 129
Open dialog box, 129
opening

camera raw images, 132-133
catalogs, 56-57
non-supported files, 239
other formats, files as, 129
PDF files, 130

Undo History palette, 168
OpenType font, 369
optimizing

catalogs, 58
JPEG document, 390-391
Photoshop Elements, 474-475
PNG-8 format, 394-395
PNG-24 format, 396

Options bar, Editor, 7, 17
Ordered Online, finding photos by, 93
Organizer. See also albums; catalogs; Date

view; Folder Location view; Map
view; palettes; Photo Browser; 
printing

adding photos from Editor, 56
commands in, 8
customizing work in, 25
docking/undocking Properties 

palette, 14-15
Editor, switching to, 9
exiting, 24
Files preferences in, 28-29
fixing images in, 7
general preferences, setting, 26-27
larger work space, creating, 10
saving files for, 146
scanner preferences, setting, 34
Sharing Center, accessing, 462
slide shows, adding content to, 426
task pane, working with, 10
viewing workspace, 6
watched folders, specifying, 42-43

orientation, 454
Page Setup options, 448
of text, 369

Orientation Metadata, 29
Other category, Keyword Tags palette, 82
Outer Glow layer style, 324

changing settings, 332-333
outline fonts, 369
Outlook/Outlook Express. See Microsoft

Outlook/Outlook Express
Out of Scratch Disk Space message, 475
ovals with Elliptical Marquee tool, 179
overexposed photos, correcting, 110
oversharpening, 281
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P
page duration, Full Screen View Options

dialog box options, 73
Page setup dialog box, 448
Paintbrush tool with adjustment layers, 234
Paint Bucket tool, 308

shortcut key for, 16
Palette Bin, 7, 11

attaching/detaching palettes, 14
Palette Knife filter, 360
palettes, 7. See also specific palettes

attaching/detaching, 14
defaults, resetting to, 15, 485
expanding/collapsing, 12-13
for indexed color, 242
More menu, 12-13
moving, 14-15
in Organizer, 10
saving locations, 477
showing/hiding, 12

Pan Camera tool with 3D Transform 
filter, 271

panning
with Control bar, 75
for slide shows, 424, 428-429

panoramas, creating, 440-441
partner services preferences, setting, 38-39
Paste command, 200-201
pasting selections, 200-201
patches, checking for, 22-23
pattern dither for bitmap images, 241
patterns

fill layers, 211, 226
with Paint Bucket tool, 308

Patterns palette, 309
Pattern Stamp tool, 309
PCX files, 149
PDAs (personal data assistants), 239
PDD files, 149

opening, 129
PDF format, 149

inserting images in, 131
metadata information, adding, 145
mobile phones, sending files to, 465
opening, 130
Photo Browser, displaying in, 68
Sharing Center, 462

slide shows, creating, 469
Pencil tool, 304

Auto Erase feature and, 304, 305
options, working with, 17
with Photomerge Faces, 436
with Photomerge Group Shot, 438-439

pen pressure for brushes, 294
People category, Keyword Tags palette, 82
percentages

with Scale commands, 272
for warped text, 371

perception rendering intent, 459
perceptual colors

for GIF documents, 392
for PNG-8 documents, 394

perspective
for panoramas, 440
Transform command option, 269
with Vanishing Point tool, 442-443

phones. See mobile phones
photo books, 412-413

Content palette, designs in, 412-413
modifying, 413

Photo Browser, 6, 64-65. See also Folder
Location view; photo projects

changing view in, 64-65
Display button, 64
Folder Location view displaying, 30
general preferences, setting, 26
hidden, marking photos as, 68-69
selecting/deselecting photos in, 71
specific photos, viewing, 68-69
videos

displaying, 68
viewing, 70

visible, marking photos as, 68-69
photo calendar, 414
photo collage, 415
photo effects, 335

applying, 336
favorites list, adding to, 342

Photo Effects button, 335
Photo Filter adjustment, 263
photographic restoration, 358
photo mail, sending files in, 464
Photomerge Faces, 436-437
Photomerge Group Shot, 438-439
Photomerge Panorama, 440-441
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photo projects, 409. See also online gallery;
photo books; slide shows

adding/removing pages in, 410
calendar, 414
collage, 415
editing in Photoshop CS3, 445
files, 149
finding, 410
finding photos used in, 93
flipbooks, creating, 422
greeting cards, creating, 417
labels, creating, 416
online gallery, creating, 418-419
opening, 410
Photomerge Faces, 436-437
Photomerge Group Shot, 438-439
resizing photos in, 444
rotating photos in, 444
saving, 411

photos. See also searching
card readers, importing from, 50-51
CDs/DVDs, importing photos from, 49
digital cameras, importing from, 50-51
files and folders, importing from, 46-47
mobile phones, importing photos 

from, 52
scanners, importing photos from, 52
searching for, 46-47
video, capturing photos from, 54
Web, preparing photo for, 404-405

Photoshop Elements Knowledge base
Photoshop Elements Online command, 19
Photoshop RAW files, 149
photo stacks. See stacks
PICT files, 149
Pictures folder, 42
PIM (PRINT Image Matching), 451
pincushion distortion, 278-279
pinning photos in Map view, 78-79
Pixar files, 149
pixelization, 127
pixels, 127. See also resolution;

selecting/deselecting; sharpening; 
sizing/resizing

color depth and, 238
color selection, removing pixels 

from, 193
Equalize command for finding, 264

Photomerge Group Shot, blending 
with, 439

ppi (pixels per inch), 127
Place command, 131
Places category, Keyword Tags palette, 82
Plastic Wrap filter, 362
plug-in options, setting, 494-495
PNG format, 149. See also PNG-8 format;

PNG-24 format
Application dither in, 386
Browser dither in, 386
compression of, 150-151
exporting photos in, 470
matte images in, 385
metadata information, adding, 145
opening, 129
with Save for the Web 

command, 380, 382
transparency, support for, 384
working with, 388-389

PNG-8 format. See also Save for the Web
command

clipart, preparing, 402-403
matted image, creating, 384-385
optimizing, 394-395
transparency in, 384
working with, 388-389

PNG-24 format. See also Save for the Web
command

matted image, creating, 384-385, 396
optimizing, 396
transparency in, 384, 396
working with, 388-389

Point Eraser tool, 189
Polygonal Lasso tool, 180-181, 184
polygons, creating, 320-321
portrait orientation, 448, 454
Portraits style for Black and White adjust-

ment, 266
Posterize option, 265

for adjustment layers, 225
ppi (pixels per inch), 127
preferences. See also Organizer

Adobe Partner Services preferences, 
setting, 38-39

album preferences, setting, 36
camera preferences, setting (See digital

cameras)
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card reader preferences, setting (See
digital cameras)

Date view preferences, setting, 35
default preferences, restoring, 477
e-mail sharing preferences, setting, 40
Folder Location view preferences, 

setting, 30
general preferences, setting, 476-477
keyword tag preferences, setting, 36
mobile phone preferences, setting, 37
plug-in options, 494-495
scanner preferences, setting, 34
slide show preferences, setting, 424-425
transparency preferences, 492
type preferences, setting, 493

Premier Elements, publishing slide shows
to, 432

preserve exact colors
for clipart, 403
for indexed color, 243

preserving text to print, 365
Preset Manager for libraries, 496-497
Preset menu, 128
Preset Resolution, 488-489
presets

creating files with, 128
zooming presets, 160

previewing
in browser, 400-401
camera raw images, 133
different color monitors, Web images 

in, 400-401
dither, 387
font size, 493
Magic Extractor selections, 189
screen size, selecting, 29
slide shows, 425
with Unsharp Mask filter, 282
Video Preview option, 128

print dialog box, 454-455
printers

preparing images for, 406-407
resolution, 408

printing, 450-451
Assign Profile command, 458
background colors, 456
borders, 453, 456
captions, printing, 456

colors
management options, 458-459
settings, choosing, 457

crop marks, 453, 456
Crop to Fit Print proportions 

option, 454
documents, 460
Editor

color management options 
in, 458-459

output options in, 456
setting options in, 454-455

filename, printing, 456
flipping images, 456
individual print options in, 453
labels, 450-451

more options for printing, 452-453
measurements, setting, 449, 488
more options for, 452
multiple layers, 461
multiple photographs, 455
Organizer, 450-451

more options in, 452-453
output options, setting, 456
Page setup dialog box, 448
positioning options, 454-455
preserving text to print, 365
rendering intent, choosing, 458-459
resolution for, 453
scaling options, 454-455
type of printer, selecting, 452

Print Photos dialog box, 450
Process Multiple Files command, 129

for camera raw files, 32
product support notifications, 38
progressive scans

JPEG, loading, 391
for photos for Web, 405

Project Bin, 7, 11
auto-hiding, 477
Bin Actions list, 135
open files, working with, 134-135
photo book, auto-filling, 412
showing/hiding, 135

projects. See also digital projects; photo
projects

Photo Browser, displaying in, 68
promotions, notification of, 38
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Properties palette, 10
docking/undocking in Organizer, 14-15

proportions
with Cookie Cutter tool, 273
with Scale commands, 272
with Standard Shape tool, 320
transform boundaries, creating, 269

PSB files, raw images as, 132
PSD format, 149

exporting photos in, 470
metadata information, adding, 145
opening, 129
for photo projects, 445
projects, saving, 411
raw images as, 132
saving preferences, setting, 479

PSE format, 149
opening, 129
for photo projects, 445
projects, saving, 411

publishing slide shows, 432-433
pucker option, Liquify filter, 350

Q
quality for photos for Web, 405
Quark Xpress, preserving text for, 365
Quick Edit, working with, 140-141
Quick Fix, 7, 9

version sets in, 120
Quick Selection tool, 185

Auto-Enhance option, 184
Quick Share palette, 10

online prints, ordering, 462
QuickTime, 54

R
Radial Blur filter, 354-355
radius with Refine Edge tool, 190
RAM, 475

cache, allocating, 475, 482-483
History States optimizing, 474
Scratch Disk, using, 474-475

random photo layout for photo books, 412
Ranking menu, 97
raster

documents, 127

images, 447
ratings

Control bar, setting with, 75
finding photos with, 97

raw images. See camera raw
reading digital watermarks, 345
reconnecting to missing files, 123
reconstruct option, Liquify filter, 351
rectangles, creating, 320-321
Rectangular Marquee tool, 178
red eye reduction

automatically fixing, 32
Auto Red Eye Fix command, 113, 289
for camera raw images, 132-133
Quick Edit, Red Eye Fix with, 140-141
Red Eye tool, 289
scanner preferences for, 34

Red Eye tool, 289
Redo button, 8
Redo command, 170-171
Reduce Noise filter, 287, 359
reduction method for colors

for GIF documents, 392
for PNG-8 documents, 394

Refine Edge tool, 190
reflection option, Liquify filter, 351
relative colorimetric rendering intent, 459
relax text selection option, 477
Remove Color Cast adjustment, 260
remove all color, 260
removing. See deleting
renaming. See naming/renaming
rendering intent for printing, 458-459
reopening notes, 175
reordering

album, photos in, 106-107
Albums palette, 100
Keyword Tags palette, 82
layers, 215
open photos, 134

repairing catalogs, 58
Repeat Slide Show option, Full Screen View

Options dialog box, 72
Replace Color adjustment, 258
replacing selections, 197
reselecting, 191
resizing. See sizing/resizing
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resolution, 127
changing image resolution, 138-139
explanation of, 408
for new files, 126
Preset Resolution, 488-489
for printing, 453
selecting, 127
with 3D Transform filter, 270

Restore button, 8
restoring

catalog backup, 62
default preferences, 477

restrictive colors
for GIF documents, 392
for PNG-8 documents, 394

Retouch tool for raw images, 133
reverse drop shadows, 329
reverse previous selection, 191
Revert command, 147
RGB (Red, Green, Blue), 127, 238

for animated GIFs, 394-395
Color dialog box for, 293
converting image to, 239
Info palette, changing measurement 

by, 166
Lighting Effects filter with, 353
for new files, 126
printing options, 457
Video Preview option supporting, 128

Rise text style, 370
RLE (Run Length Encoding), 151, 402

printers, preparing images for, 407
Rotate commands, 276
Rotate Left/Rotate Right buttons, 115
rotating, 276-277

camera raw images, 133
with Control bar, 75
with Guided Edit, 142
JPEGs with Orientation Metadata, 29
90 degrees left or right, 115
open photos, 135
photo project, photos in, 444
slides in slide show, 427
with 3D Transform filter, 271
TIFFs, 29

roughness for gradients, 315
rounded rectangles, creating, 320-321

roundness
with Background Eraser tool, 311
with Bevel layer style, 330
with Brush tool, 303

rulers
options, setting, 488-489
showing/hiding, 167
zero origin, changing, 167

S
sampling all layers

with Blur tool, 283
with Magic Eraser tool, 312
with Paint Bucket tool, 308
with Sharpen tool, 281
with Smudge tool, 307
with Spot Healing Brush, 288

San Disks, 32
saturation

adjustment layers for, 225
for camera raw images, 132
Color dialog box for, 293
Color Variations adjustment and, 259
Hue/Saturation adjustment, 257
printing, rendering intent for, 459
with Sponge tool, 257

Save As command, 147
Save commands, 147
Save for the Web command, 380-381

options, working with, 382-383
size settings for image, 

changing, 382-383
Save for Web dialog box, 397
Save Optimized As dialog box, 385

HTML files, creating, 389
saving. See also backing up; Save for the

Web command
brush sets, 300
Color Swatches palette, colors for, 247
digital projects, 411
files, 146-147
last saved version, reverting to, 148
palette locations, 477
photo projects, 411
preferences, modifying, 478-479
selections, 196-197
version sets, manually saving, 120-121
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Saving Files preferences, 478-479
scalable fonts, 369
scale

layer style scale, changing, 326-327
printing options, 454-455

Scale commands, 272
scanners

cropping scanned photos, 274-275
Divide Scanned Photos command, 274
images into files, scanning, 131
importing photos from, 52
noise from, 359
for photos for Web, 405
preferences, setting, 34
straightening scanned photos, 274-275

scatter with Brush tool, 303
Scenic Landscape style for Black and White

adjustment, 266
Scitex CT files, 149
Scratch Disk, 474-475

options, setting, 481
scratches

Guided Edit, touching up with, 143
removing, 358

scratch size, Status bar information on, 173
Screen blending mode, 230
screen savers, creating, 472
scroll wheel, zooming with, 477
searching

excluding photos from search, 91
Find bar, searching for photos with, 91
Find menu, finding photos with, 92-93
by keyword tags, 90
by metadata details, 94-95
for missing files, 28
modifying search criteria, 94-95
for photos, 48
ratings, finding photos with, 97
smart albums, 104-105
Timeline, finding photos with, 96

Season, sorting content by, 337
selecting/deselecting. See also specific

tools
adding to existing selection, 194
another selection, pasting selection into,

200-201
contracting/expanding, 192

copying selections, 200-201
cropping selection, 194-195
deleting saved selection, 198
framing selection with new borders, 192
layers, 208
loading saved selection, 198
masks with selection, creating, 235
modifying existing selection, 191
moving selections, 202
new selection modified with saved 

selection, 198-199
in Photo Browser, 71
previously saved selection, 

modifying, 191
saving selections, 196-197
shapes on layer, 318
similar color to selection, adding, 193
for standard monitor, 178
subtracting from existing selection, 194

Selection Brush tool, 187
selection tools, 347
selective colors

for GIF documents, 392
for PNG-8 documents, 394

sending files
in e-mail, 463
to mobile phones, 465
in photo mail, 464

serial number, 2
Setup Organizer dialog box, 41
Shadow Distance option for layer 

styles, 324
Shadow/Highlight adjustment, using, 254
shadows. See also drop shadows

Color Curves adjustment and, 256
Color Variations adjustment and, 259
with Dodge and Burn tools, 285
with Guided Edit, 142
Levels adjustment, application of, 253
Quick Edit, lightening with, 141
Shadow/Highlight adjustment, 

using, 254
shape layers, 205

creating shapes, 317
moving shapes on layer, 318
normal image layer, converting to, 211
selecting shapes on layer, 318
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simplifying shapes, 318
Shape Marquee tools, 17
Shape options, with Cookie Cutter tool, 273
shapes. See also shape layers

Content palette, adding shapes 
from, 338

Custom Shape tool, 322
Standard Shape tool, 320-321

Shape Selection tool, 318
Shapes styles, 337
Shared Online, finding photos by, 93
Sharing Center, 462
sharpening, 112

Adjust Sharpness filter, 280
with Guided Edit, 142
with Quick Edit, 14
with Reduce Noise filter, 359
Sharpen tool, 281

Sharpen tool, 281
Shell Lower/Upper text styles, 370
shield color, setting, 486
Shift key for tool switch, 477
shift pixels option, Liquify filter, 351
shortcuts. See also keyboard shortcuts

with Navigator palette, 154
shortcuts bar, 8
showing/hiding

bins in Editor, 11
borders, 65
with Control bar, 75
dialog boxes, 26
file names, 65
grid lines, 65
layers, 214
layer styles in image, 325
marking photos as hidden, 68-69
multiple filters, effects of, 346
Navigator palette, 155
open photos, 134
Organizer task pane, 10
palettes, 12
Project Bin, 135, 477
rulers, 167

shutter speed information on file, 144-145
Side by Side view

Control bar in, 75
viewing photos in, 74

simplifying
layers, 211
shapes, 318

sizing/resizing. See also slide shows
adjustment layers and size, 224
with Background Eraser tool, 311
with basic Eraser tool, 310
Bevel layer style settings, 330
bins in Editor, 11
with Blur tool, 283
Brushes palette, 296
with Brush tool, 302
canvas size, changing, 138-139
Content palette graphics, 338
with Cookie Cutter tool, 273
cropping photos, 114
for Drop Shadow layer style, 329
Full Screen View Options dialog box

options, 73
image size, changing, 138-139
with Impressionist tool, 306
Inner Glow layer style settings, 333
multiple files, 137
Organizer task pane, 10
Outer Glow layer style settings, 333
Page Setup options, 448
Photo Browser preferences, setting, 26
photo project, photos in, 444
preview screen size, selecting, 29
Save for the Web command, resizing

image with, 382-383
Scale commands, 272
with Sharpen tool, 281
with Smudge tool, 307
specific sized object, creating, 165
Status bar information, 173
Stroke layer styles settings, 334
thumbnails, 65
Web, photos for, 405

Skew option, Transform command, 269
skin tone

adjusting color for, 261
Guided Edit, correcting with, 143

Skin Tone Eyedropper tool, 143
Slide Show Editor, 423, 427
Slide Show Output dialog box, 432-433
Slide Show Preferences dialog box, 424-425
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slide shows
audio

adjusting, 430
captions, 425

clipart, adding, 430
colors

adding, 428
for text, 431

content, working with, 426
creating, 423
deleting slides from, 426
editing, 427
effects, adding, 428-429
fonts for text, 431
looping

Full Screen View Options dialog box
options, 73

slide shows, 432
narration, adding, 431
for online gallery, 418
panning in, 424, 428-429
PDF slide shows, creating, 469
preferences, setting, 424-425
publishing, 432-433
sizing/resizing

clipart, 430
slides, 427

text, adding, 430-431
time, adjusting, 430
VCD with menu of, 434-435
zooming in, 428-429

smart albums. See albums
Smart Blur filter, 354
Smart Fix with Quick Edit, 140-141
smart objects, converting image layer 

to, 211
Smooth command, 192-193
smoothing

with Refine Edge tool, 190
with Standard Shape tool, 320

Smoothing Brush tool, 189
smoothness for gradients, 315
Smudge tool, 306-307
Snap To option

for grids, 490-491
with guides, 174
with Standard Shape tool, 320

solarization with Color Curves 
adjustment, 256

solid color layers, 226
for gradients, 314
normal image layer, converting to, 211

sorting
albums, photos in, 106
with Content palette, 337
Photo Browser, sorting photos in, 69

soundtracks for slide shows, 425
spacing

with Background Eraser tool, 311
Brush tool, setting with, 303

Spatter filter, 362
special effects brushes, 294
Sphere tool with 3D Transform filter, 270
Sponge tool

effects of, 286
saturation/desaturation with, 257
use, 286

Spot Healing Brush, 143, 288
square brushes, 294
squares, creating, 320-321
Squeeze text style, 370
stacking order

changing, 216
moving, 206
slide show, clipart for, 430

stacks. See also version sets
all photos in stack, viewing, 118
automatically suggesting, 32
creating, 116
deleting photos from, 118-119
editing photos in, 119
top photo, specifying, 118
unstacking photos, 116
visually similar photos, automatically

stacking, 117
Stained Glass filter, 362
Stamp filter, 361
standard Macintosh color monitor display,

previewing, 401
standard program install, performing, 2
Standard Shape tool, 320-321

options, working with, 17
standard type tools, 364-365
standard Windows color monitor display,

previewing, 401
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starburst icon, 324
star ratings. See ratings
starting Photoshop Elements, 4
stationary for photo mail, 464
Status bar, 173
Stock Photos

Adobe Updater Preferences dialog box
for, 4

image information, displaying, 145
Straighten and Crop Image 

command, 274-275
Straighten Image command, 274-275
Straighten tool, 274
straightening

with Guided Edit, 142
raw images, 133
scanned photos, 274-275
with tool, 274

straight lines, drawing, 304, 305
strength

with Blur tool, 283
with Sharpen tool, 281
with Smudge tool, 307

strikethrough option for type, 368
Stroke layer styles, 334
strokes

creating, 248
with Photomerge Faces, 436-437
with Photomerge Group Shot, 438-439
thumbnails, 295

Stroke Selection command, 248
Stroke Size or Opacity option for layer

styles, 324
styles. See also layer styles

with Custom Shape tool, 322
for grids, 490
with Impressionist Brush tool, 306
with Line tool, 319
predefined style sets, 337
with shape layers, 317
for slide show text, 431
with Smudge tool, 307
sorting content by, 337
with Standard Shape tool, 320
for warped text, 370

Style Settings dialog box, 324
Stylus Pressure with Liquify tool, 352

sub-categories. See Keyword Tags palette
Subtract from Selection tool, 189
subtracting

pixels, 127
from saved selection, 197, 199

sync panning with Control bar, 75
system requirements, 2

T
tablecloth, 492
tags. See keyword tags
tan skin tone, adjusting, 261
Targa files, 149
task panes, 10
Tate-Chuu-Yoko option for Asian type, 367
tear marks, touching up, 143
television slide shows, 432-433
temporary composite image, creating, 233
text. See also notes; type layers; type

masks; Type tools
anti-aliasing option, setting, 368-369, 372
Brushes palette views, 295
colors for, 365, 369
Content palette, adding from, 337, 340
deleting, 365
fonts, working with, 368-369
gradient fill, applying, 378
Inner Glow layer style, chiseled text

with, 333
labels, printing, 451
preferences, setting, 493
preserving text to print, 365
relax text selection option, 477
slide shows, adding to, 430-431
warped text effects, 369, 370-371

Text Effects, 337
text layers, 364

editing type in, 366
textures

with Lighting Effects filter, 353
photo effects, 335

themes in Content palette, 337, 340
thick heavy brushes, 294
third party services, notification of, 38
3-D effects. See also chiseled type

with Lighting Effects filter, 353
3D Transform filter, 270-271
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threshold, 265
with Unsharp Mask filter, 282

thumbnails. See also Navigator palette;
Project Bin

Brushes palette views, 295
Layers palette options, 236
layer thumbnails, 164, 215
of library items, 496
resizing, 65
saving file data, 147

Thumbnails view, 64
TIFF format, 149

camera raw images as, 132
exporting photos in, 470
metadata information, adding, 145
opening, 129
photos for Web, preparing, 404
printers, preparing images for, 406-407
rotating TIFFs with Orientation 

Metadata, 29
Tile command, 162-163
Timeline, finding photos with, 96
times. See dates and times
time zone, adjusting times for, 122
timing, Status bar information, 173
tips. See Brushes palette
titles for online gallery, 420-421
tolerance

with Background Eraser tool, 311
with Color Replacement tool, 316
with Impressionist tool, 306
with Magic Eraser tool, 312
with Paint Bucket tool, 308

tonal range. See also Histogram palette
adjustment layers for, 225
Color Curves adjustment, 256
Gradient Map adjustment and, 262
Invert command, 264
Levels adjustment, working 

with, 252-253
Toolbox, Editor, 7
tools. See also specific tools

multiple tools, accessing, 16
Status bar information, 173
toggling between, 487
working with, 16-17

ToolTips, preferences for, 476
top photo in stack, specifying, 118

transformation tools
Adjust Sharpness filter, 280
Blur tool, 283
Burn tool, 285
Clone Stamp tool, 284
Correct Camera Distortion filter, 278
Dodge tool, 285
flipping images, 276-277
Free Transform command, 268-269
Healing Brush tool, 287
Red Eye tool, 289
rotating images, 276
Scale commands, 272
Sharpen tool, 281
Spot Healing Brush, 288
3D Transform filter, 270-271
Transform command, 268-269
Unsharp Mask filter, 282

Transform command, 268-269
transitions. See also fades

display options, setting, 486
for slide shows, 424
slide shows, adding to, 428

transparency
for animated GIFs, 394
with brushes, 297
clipart, options for, 403
with GIF documents, 384, 393
for gradients, 313
for indexed color, 242
in PNG-8 format, 384, 394
in PNG-24 format, 384, 396
preferences, controlling, 492
preserving, 384
printers, preparing images for, 407
transparent layers, 384

Auto Erase with, 305
TrueType font, 369
Tsume option for Asian type, 367
turbulence option, Liquify filter, 350
Turbulent Jitter tool, 352
Twain plug-in, 131
twirl options, Liquify filter, 350
Twist text style, 370
two different views, opening photos 

in, 162-163
Type, sorting content by, 337
typefaces, 369
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type layers, 205
normal image layer, converting to, 211

type masks
creating, 373
isolating image pixels with, 374-375
moving, 374

Type 1 PostScript font, 369
Type tools

anti-aliasing option, setting, 372
Asian type, working with, 367
editing type in text layers, 366
fonts, working with, 368-369
options, working with, 368-369
standard type tools, 364-365

U
uncompensated color monitor display, pre-

viewing, 401
underexposed photos, correcting, 110
underlining type, 368
Undo button, 8
Undo command, 170-171
Undo History palette, 168

clearing memory, 172
More button, 169, 170
multiple undos, performing, 171
preferences, setting, 484
using, 169-170

undoing/redoing, 18
keyboard shortcut, changing, 485
with Undo History panel, 170-171

Undo/Redo slider, 168, 170-171
units options, setting, 488-489
unmanaged files, 66-67
Unsharp Mask, 280, 282
unstacking photos, 116
untagged photos, searching for, 92
updates

Adobe Updater Preferences dialog 
box, 4

catalogs from previous version, 58
checking for, 22-23
partner service updates, notification 

of, 38
Urban/Snapshots style for Black and White

adjustment, 266
USB drives, 475

Use a Supplementary Editing Application
check box, 31

V
Vanishing Point tool, 442-443
vCard files, importing, 466-467
VCD with menu of slide shows, 434-435
vector graphics, 320
versions. See also version sets

last saved version, reverting to, 148
version sets

all photos in set, viewing, 120
deleting and editing photos, 120-121
Find menu, searching in, 92
saving version set with original, 146

Vertical Type Mask tool, 372
for chiseled type, 376-377
isolating image pixels with, 374-375

vibrancy for camera raw images, 132
Video Preview option, 128
videos. See also Photo Browser

capturing photos from, 54
flipbooks, creating, 422
for online gallery, 418
VCD with menu of slide shows, 434-435

views and viewing. See also Folder
Location view; Photo Browser

Brushes palette, 294
Date view, viewing photos in, 76-77
Full Screen view, viewing photos 

in, 72-73
guides, 174
Map view, viewing photos in, 78-79
Navigator palette, changing view size

with, 154
notes, 175
Side by Side view, viewing photos in, 74
Timeline, viewing photos with, 96
two different views, opening photos 

in, 162-163
workspaces, viewing, 6-7

vignetting, 278-279
Vintage Photo effect, 335, 336
Visibility layer style, 324
visible, marking photos as, 68-69
visual similarity

searching for photos by, 92
stacking automatically, 117
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W
Wacom tablets

Brush tool options for, 303
using, 498

wallpaper, using photos as, 472
warning dialog boxes, displaying, 26-27
warped text effects, 369, 370-371
warp option, Liquify filter, 350
watched folders, 42-43

changing settings, 42-43
Folder Location view, working in, 66
removing folders, 42-43

watermarks
Digimarc watermarks, 28-29
digital watermarks, 345

Wave text style, 370
WBM files, 149
Web documents. See also GIF format; JPEG

format; PNG format; PNG-8 format;
PNG-24 format; Save for the Web
command

browsers, previewing images in, 400-401
clipart, preparing, 402-403
different color monitors, previewing 

in, 400-401
file formats, working with, 388-389
file size, optimizing image to, 397
photos, preparing, 404-405

Welcome Screen, 5
Welcome Screen dialog box, 4

using, 5
wet media brushes, 294
White Balance tool, 133
width. See height/width
windows. See also multiple windows

centering document windows, 477
moving images in, 161

Windows, Microsoft. See Microsoft
Windows

WMV format
for flipbooks, 422
slide shows, publishing, 432
VCD with menu of slide shows, creating,

434-435
video, capturing photos from, 54

Word, sorting content by, 337
workflow, 447
workspaces, viewing, 6-7

Wow layer styles, 324
Write Keyword Tag and Properties info to

Photos, 95
WYSIWYG fonts, 394

X
XML (Extensible Markup Language)

albums, exporting, 107
keyword tags, exporting, 87

XMP files
attaching information to, 144-145
Software Development Kit, 145

Y
Yahoo! maps. See Map view

Z
zero origin of rules, changing, 167
ZIP format, 151

printers, preparing images for, 407
zooming in/out, 158-159. See also Navigator

palette
camera raw images, 133
with Control bar, 75
increasing/decreasing magnification, 160
with Liquify filter, 351
in Map view, 79
in multiple documents, 160
with Navigator palette, 154-155
preferences for, 476
presets for, 160
with scroll wheel, 477
for slide shows, 424
in slide shows, 428-429

Zoom In/Zoom Out commands, 157
Zoom tool. See also zooming in/out

changing view with, 158-159
with Correct Camera Distortion filter, 278
multiple windows, working in, 162-163
with Save for the Web command, 382
with 3D Transform filter, 270
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